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Click a Calculator Key for the keyboard equivalent

      View all

Notes:
      To access the keyboard's Numeric Keypad, the Num Lock key must be activated.
      Optionally, the extended numeric keys 10-15 can be entered via the keypad.    With Num 

Lock key activated, use the Alt key in conjunction with numeric digits 0-5 to enter them.
      The Deg, Rad & Grad option buttons can be changed by using the Page Up or Page Down

keys.
      Note, that in the FIS    mode the decimal point and exponent key is disabled and in the 

DEC & MET modes the 10-15 keys are disabled.    When disabled, these keys will appear 
grayed and will be inaccessible.
      Calculator Keys Described      (Click Calculator Icon)      



Click the part of the Calculator Window you want to know more
about.

      See Keyboard Interface.
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Shift    F1 



Shift    F2 



Shift    F3 



Shift    F4 



Shift    F5 



Shift    F6 



Shift    F7 



Shift    F8 



Shift    F9 



Shift    F10 



Shift    F11 



Shift    F12 



Alt S 



Alt D 



Alt T 



Alt 0 



Alt 1 



Alt 2 



Alt 3 



Alt 4 



Alt 5 



Alt +    or    Alt - 



Alt Q



Alt X



Alt P



Key accessed via Numeric key pad.    See notes below.



PageUp or PageDown key



Home key



End key



Insert key



Alt /



Num Lock key



Calculator Keys 
Keyboard 
Equivilents

BEV Shift    F1
RUN Shift    F2
RIS Shift    F3
SLP Shift    F4
INV Shift    F5
SIN Shift    F6
COS Shift    F7
TAN Shift    F8
RCL Shift    F9
STO Shift    F10
REM Shift    F11
DRG Shift    F12
FIS Alt    S
DEC Alt    D
MET Alt    T
10 Alt    0
11 Alt    1
12 Alt    2
13 Alt    3
14 Alt    4
15 Alt    5
1/X Alt    /
SQR Alt    Q
X² Alt    X
0-9 & +, -, ×, ÷, = Numeric key pad 
± Alt    +    OR    Alt    -
C Home
CE End
EE Insert

Alt    P

 The FIS Key allows input in Feet, Inches and Sixteenths format.    In this mode the Extended 
Numeric Keys are activated.    Calculations performed in this mode will be displayed in their 
lowest terms (i.e. 1' - 6 8/16"    will become    1' - 6 1/2" etc...) with the exception of main 
display area two, which will always display Feet, Inches and Sixteenths in the FIS mode.    
When switching between modes FIS, DEC & MET, the display and the Memory pull down 
menu values will automatically convert to the new mode format while the Constant pull 
down menu values will remain the same.    Upon exiting Conversion Master, the last mode 
change can be retained when initialization file is updated.
The MET mode treats all input as Meters.    In this mode the Extended Numeric Keys are 
deactivated.    When switching between modes FIS, DEC & MET the display and the Memory 
pull down menu values will automatically convert to the new mode format while the 
Constant pull down menu values will remain the same.    Upon exiting Conversion Master, the
last mode change can be retained when initialization file is updated.
The DEC key treats all input as feet.    In this mode the Extended Numeric Keys are 
deactivated.    When switching between modes FIS, DEC & MET the display and the Memory 
pull down menu values will automatically convert to the new mode format while the 
Constant pull down menu values will remain the same.    Upon exiting Conversion Master, the
last mode change can be retained when initialization file is updated.
The Extended Numeric Keys (10-15) allow for input values of 10 & 11 when inputting 



inches and values 10-15 when inputting sixteenths in the FIS mode.    When inputting inches 
and sixteenths, always use a single key stroke.      The extended numeric keys are 
deactivated in the DEC and MET modes.
When performing division in the FIS mode there may be a remainder or an overage because 
the calculator will round to the nearest Specified Fractional Accuracy. A positive value 
signifies a remainder and a negative value denotes an overage.    This value can be 
determined by the REM key.    In order to alert the user the REM key will be highlighted in 
red when a remainder or an overage occurs.    Also See Options Menu to set display 
accuracy.
The RCL & STO keys allow you to store and recall up to 9 memory locations.    These areas 
are accessed by selecting either the RCL key or    the STO key and a numeric key of 1 to 9.    
These memory locations can optionally be accessed from the memory pull down menu on 
the menu bar.    Also, the RCL key can be used to recall the last entered BEV, RUN, RIS and 
SLP values.
The BEV key is used to enter the bevel of an acute angle of a right triangle.    The bevel can 
be further defined as the amount of rise in inches over one foot (i.e. the pitch on a roof) or 
the tangent of the angle.    The Bevel/Tangent can be calculated when any two sides of a 
right triangle are known Run/Side Adjacent, Rise/Side Opposite or Slope/Hypotenuse.    The 
Bevel can be entered as a FIS, DEC or MET number.    When the bevel and any other side of 
the right triangle are known the INV BEV key combination can be used to simultaneously 
display the Bevel, Run, Rise, Slope and the Angle in degrees, minutes and seconds.    A 
conversion can be performed at any point by pressing FIS, DEC or MET key for the desired 
mode change.    See    BEV, RUN, RIS and SLP key overview.
The RUN key is used to enter the amount of run of a right triangle.    This value can be 
entered in all three modes.    See    BEV, RUN, RIS and SLP key overview.
The RIS key is used to enter the amount of rise of a right triangle.    This value can be 
entered in all three modes.    See    BEV, RUN, RIS and SLP key overview.
The SLP key is used to enter the amount of Slope or the Hypotenuse of a right triangle.    
This value can be entered in all three modes.    See    BEV, RUN, RIS and SLP key overview.
The BEV, RUN, RIS and SLP keys are used to solve right triangles. Upon entering any two 
values, the calculator solves for the remaining sides.    The Calculator uses the last two input 
values (Bevel, Run, Rise or Slope) to solve the triangle.    You can force the calculator to view 
the Bevel, Run, Rise or Slope as its last input by pressing the RCL and then BEV, RUN, RIS or 
SLP key.    This is useful when one of these stored values are needed to solve another 
triangle.    This key combination will put the selected value in the calculator's main display.    
When the any two values are known the INV BEV key combination can be used to 
simultaneously display the Bevel, Run, Rise, Slope and the Angle in degrees, minutes and 
seconds.
The DRG key changes the calculator angle mode to Degrees, Radians or Grads without 
doing a conversion on the displayed value.    See also Degree, Radian & Gradian Option 
buttons.
The Deg, Rad and Grad Option buttons change the calculator angle mode to Degrees, 
Radians or Grads and perform a conversion on the displayed value.      See also DRG key.
The SIN COS & TAN keys calculate the Sine, Cosine or Tangent of the displayed value.    The
Calculator will also simultaneously display the Arc Sine, Arc Cosine or Arc Tangent of the 
angle along with the angle in Decimal of Degrees, Degrees·Minutes·Seconds format, Radians
and Grads.    See also INV & DRG keys.
The INV key is used in conjunction with SIN COS & TAN keys to calculate the smallest 
relative angle of the displayed value i.e. Arc Sine, Arc Cosine and Arc Tangent.    The 
Calculator will also simultaneously display the Sine, Cosine or Tangent of the relative angle 
along with the angle in Decimal of Degrees, Degrees·Minutes·Seconds format, Radians and 
Grads.    Optionally the INV key can be used with the BEV key to display the stored    Bevel, 
Run, Rise Slope and Angle.      See Also DRG key.
The 1/X Reciprocal key divides the displayed value of the Calculator X into 1.
The SQR key calculates the Square Root of the displayed value. See also X² key.



The X² key Squares (XxX) the displayed value.    See also SQR key.
The Standard Numeric Keys input calculator digits 0 - 9.    See also Extended Numeric 
Keys.
The Decimal Point key allows for inputting decimals of feet.    This key is deactivated when 
the calculator is in the FIS mode.
The Operator keys perform the various arithmetic functions ( +, -, ×, ÷, =, ± ).

The  key displays the value of Pi truncated to 11 digits (3.14159265359).    
This value can and will be further truncated based on the setting of the decimal accuracy.    
See Options menu for the setting of caluclator accuracys.
The Cancel Key cancels all pending Calculator operations and sets the calculator displays 
to zero.    Clicking this key twice in succession will clear the values that were stored by using 
BEV, RUN, RIS or SLP keys.    See also Cancel Entry Key.
The Cancel Entry Key cancels numeric entries and sets the calculator displays to zero.    
See also Cancel Key.
The Enter Exponent Key raises the value of the main calculator display to  power where

 is the value enter after the EE key is pressed.    This key is disabled in the FIS mode.



Shows the active state of the NumLock key.    The NumLocks must be on to use the Keyboard 
Interface.



Display #1
      In FIS mode displays Feet and Inches in decimal format

      In DEC mode displays feet in decimal format.

      In MET mode displays Meters in decimal format.

      This is the active input display in the DEC & MET modes.

      When a Trig function key is pressed the calculator displays the Angle in decimal, 
(Arc)sine, (Arc)cosine & (Arc)tangent information in display area number one.

      This display will also alternate Trigonometric information based on which option button is
selected.
            See Degrees, Radians, or Grads.

      When a BEV, RUN, RIS or SLP key is pressed the calculator displays Bevel, Run, Rise and 
Slope information in both display areas.

      Display Blocks

                Display blocks' 1-1 & 2-1 are limited to 26 characters, Display area #2 is limited to 
31 characters.    Upon occasion, when working with very large numbers, you may receive a 
display overflow message.    If this occurs you can view the value by forcing it to the main 
display.    This can be achieved by switching Calculator modes or when dealing with Bevel, 
Run, Rise, Slop functions, by clicking    the RCL key in conjuction with the desired function 
key.



Display #2
      In FIS mode displays Feet, Inches & 16ths format i.e. 12' - 4 13/16".

      In DEC mode displays Feet, Inches 16ths & decimal of inches formats.

      In MET mode displays Feet, Inches 16ths &    millimeters.

      This is the active input display in the FIS mode.

      When a Trig function key is pressed the calculator displays Radians, Grads·and 
Degrees·Minutes·Seconds (45°·15'·13") data in display area number two.

      When a BEV, RUN, RIS or SLP key is pressed the calculator displays Bevel, Run, Rise and 
Slope information in both display areas.

      This display area can be deactivated/hidden from view (See Options) in the DEC and 
MET modes.    If deactivated, it will automatically reactivate when switching to the FIS mode 
or when using the BEV, RUN, RIS and SLP functions.

      Display Blocks

                Display blocks' 1-1 & 2-1 are limited to 26 characters, Display area #2 is limited to 
31 characters.    Upon occasion, when working with very large numbers, you may receive 
a display overflow message.    If this occurs you can view the value by forcing it to the 
main display.    This can be achieved by switching Calculator modes or when dealing with 
Bevel, Run, Rise, Slop functions, by clicking    the RCL key in conjuction with the desired 
function key.



WEIGHTS
Avoirdupois weight - abv. (avdp.) An English and American system of weights in which:

ton = 2000 pounds
poun
d

= 16 ounces

ounc
e

= 16 drams

Apothecaries' weight - abv. (apoth.) System of weight used chiefly by Pharmacists in 
which:

scrupl
e

= 20 grains 

dram = 3 scruples
ounce = 8 drams
pound = 12 ounces

Troy weight - Systems weights for gold, silver, gem, etc... in which:

Pennyweig
ht

= 24 grains

ounce = 20 pennyweights
pound = 12 Ounces
pound = 480 grams

MEASURES
Apothecaries' measure - abv. (apoth.) System of measures used chiefly by Pharmacists in
which:

fluid 
dram

= 60 minims

fluid 
ounce

= 8 fluid drams

pint = 16 fluid ounces
gallon = 8 pints



Common Conversion Abbreviations
IST. - International Steam Table
Int. - International measurement
Brit. - British measurement
US. - United States measurement
MKS - Meters, Kilograms, Seconds
CGS - Centimeters, Grams, Seconds
SI - International System of Units



Length and Distance
Statue mile - A unit of linear measure used in the U.S. and Great Britian, equal to about 
5,280 feet
Nautical mile - A unit of linear measure for ships and aircraft, equal to 6,076 feet.    Also, 
called the geographical mile.



Time Defintions
Calender year - The conventional calendar year of 365 days can be used in rough 
calculations only; the modern calendar is based on the Gregorian year of 365.2425 mean 
solar days, the value chosen by Pope Gregory XIII in 1582.    This value requires that a leap-
year day be introduced every four years as February 29, except that centennial years (1900,
2000, etc...) are leap years only when divisible by 400.    The remaining difference between 
the Gregorian year (See tropical year below) and the tropical year introduces an error of 1 
day in 3300 years.
Sidereal year - The sidereal year is the interval in which the earth completes one 
revolution in its orbit around the sun measured with respect to the fixed stars.
Tropical year - The tropical year is the interval between successive vernal equinoxes and 
has been defined by the International Astronomical Union for noon of January 1, 1900 as 
31,556,925.9747 seconds = 365.24219879 mean solar days.    The tropical year decreases 
by approximately 5.3 milliseconds per year.
Lunar month - The interval from one new moon to the next, equal to about 29.5 days.
Lunar year - A period of 12 lunar months.
Mean sun - A fictitious sun used for time keeping that moves uniformly along the celestial 
equator and maintains constant rate of apparent motion.
Mean solar time - Time that is based on the motion of the mean sun and that has the 
mean solar second as its unit -- called also mean time.



Conversion Master Engineering Calculator
Version 2.01

RegistrationForm/Invoice

Ordering by check:    To order by check send this order form and a check to:

Rog
er 
Mos
eby
118
02 
E. 
79th
St. 
N.
Ow
ass
o, 
OK.
740
55

    Credit Card Ordering: Available through CompuServe's Software Registration Service:    enter 
GO SWREG at the ! prompt and follow the menus.    Registration id 2174

Presently working on other avenues of Credit Card Ordering.

Site licenses: A site license for Conversion Master entitles an organization to receive one copy of the 
distribution package and duplicate the distribution disk for the specified number of copies.

Please check one: 5.25" Disk ____    3.5" Disk ____

Prices guaranteed through August, 1994.
All amounts in U.S. dollars
Conversion Master single copy: quantity ___ @ $ 33.00 ea. = _________
Site license for up to    9 copies:    $261.00          = _________
Site license for up to 25 copies:    $625.00        = _________
          (more than 25 copies are negotiable)
          Shipping and Handling:

 United States $3.00
 Canadian $3.50
 Overseas $5.00

Oklahoma residents add 7.50% sales tax        + _________
                                                                                        Total payment            _________

                          Name: ________________________Date:____________

                Company: ________________________________________

                    Address: ________________________________________

City, State, Zip: ________________________________________



                    Country: _________________________________________

          Day Phone: _______________    Eve:    ____________________

Electronic Mail address: _________________________________

How did you hear about Conversion Master? 
______________________________________________________

Comments:





Index to Calculator Examples
All examples assume default accuracy settings

Basic Examples:
      FIS key Entry
      Multiplication by Whole Numbers
      Multiplication by FIS Number
      Division by Whole Numbers in FIS mode
      Division by FIS Number
      Calculating Concrete Slabs
      Calculating Concrete Footings
      Calculating Stair Risers

Using Conversion Tables:
      Cylinder volumes in cubic feet & gallons
      Using volumes to calculate cylinder lengths
      Volume of a cone

Solving Oblique Triangles:
      Example # 1
      Example # 2
      Example # 3

Solving Right Triangles:
      Example # 1    (Using BEV & RUN keys)
      Example # 2    (Using RIS & SLP keys)
      Example # 3  (Using RIS key with angle)
      Example # 4    (Solving in Meter Mode converting to FIS)
      Example # 5    (Calculating Roof Rise & Slope)

Calculating Circular Segments:
      Example # 1

Combination Triangles:
      Example # 1



FIS KEY ENTRY
To enter 14' - 11 15/16".
14 feet, 11 and 15/16 inches.

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
1      4      11      15 14' - 11 15/16" # 2 *

To enter 11 /12/16".
11 and 12/16 Inches.

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
11      12 11 12/16" # 2 3/4 = 12 Sixteenths

To enter 11 /12/16".
11 and 12/16 Inches.

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
11      12 11 12/16" # 2 3/4 = 12 Sixteenths

To enter 17' - 0".

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
1    7    0    0 17' - 0" # 2 Press 0 twice to shift 17 to the feet

position

*Notes:
                      Use single key entries to enter Inches and Sixteenths.
                      If you had entered the digits 1 & 5 for 15/16 you would have entered 1 inch and 
5/16.



MULTIPLICATION BY WHOLE NUMBERS

What is the total linear length of 18 spaces equally spaced
4' - 7 7/8" apart?

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
4      7      14 4' - 7 14/16" # 2 14/16" = 7/8"
X
1      8      0      0 18' - 0" # 2 18 as a whole 

number
= 83' 9 12/16" # 2 length = 83' - 9 

3/4"



MULTIPLICATION BY (FIS) NUMBERS
What is the square footage of a room that is 12' - 7 5/8" by 14' - 10 3/8".

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
1      2      7    10 12' - 7 10/16" # 2
X
14      10      6 14' - 10 6/16" # 2
= 187.820204 # 1 Total area in 

(ft²)



DIVISION BY WHOLE NUMBERS
If you have a length L = 64' - 0" and you want 15 equal spaces.
How far are the spaces apart (S = ?) and is there a remainder?

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
6      4      0      0 64' - 0" # 2 ' L '
/
1      5      0      0 15' - 0" # 2  15 as a whole 

number
= 4' - 3    3/16" # 2 ' S '
REM 3/16" # 1 3/16" Remainder

      See also,    Calculating stair risers example for further explanation of the REM key



DIVISION BY (FIS) NUMBERS
You have added up a linear wall length of 178' - 10" and you want to calculate
how many 2 x 4 studs it will take to build the wall on 16" centers.

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
1      7      8      10     

0
178' - 10" # 2

/
1      4      0 1' - 4" # 2 1' - 4" = 16"
= 134.12500033 # 1 134.125 studs 

required



CALCULATING STAIR RISERS

            The overall height of the stairs is 10' - 0".    You want each stair riser to be 7 1/4" in 
height.    How many risers are there?

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
1      0      0      0 10' - 0" # 2 Overall height of stairs
STO      1 10' - 0" # 2 Store height of stairs
/ 10' - 0" # 2
7      4 7 4/16" # 2 Desired height of risers
= 16.55172405 # 1 Number of risers 

required
RCL      1 10' - 0" # 2 Recall height of stairs
/ 10' - 0" # 2
1      7      0      0 17 # 1 Number of risers 

rounded
17 entered as whole #

= 7 1/16" # 2 Height of each riser
See *Note 1

REM -1/16" # 1-1 The neg. 1/16 indicates
an overage    See *Note

2

    Notes:
              1)    After doing FIS division note the status of the REM key.    It will be highlighted in 

red if an overage or a remainder has occurred.    In this case, an overage.
              2)    The REM key informed us that an overage occurred since 7 1/16"    X    17    =    10' 

- 0 1/16", hence an overage of 1/16".
              3)    Suppose you had desired risers of 7 11/16" each over a span of 9' - 0" you would 

have needed 14 risers.    Dividing 14 into 9' - 0" would have produced a remainder of 3/8"
since 7 11/16" X 14 = 8' - 11 5/8".



CALCULATING CUBIC YARDS
EXAMPLE # 1

    How may cubic yards of concrete are in a slab
    17' - 6" Wide,          66' - 8" Long    and    4" Thick?
    There are 27 cubic feet in a cubic yard.

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
1      7      6      0 17' - 6" # 2 Width
X 17' - 6"
6      6      8      0 66' - 8" # 2 Length
X 1166'- 8" # 2
4      0 4" # 2 Thickness
= 388.88888502 # 1 Cubic feet 
/ 388.88888502 # 1
DEC 388.88888502 # 1 change mode
2      7 27 # 1 *See Note below
= 14.40329204 # 1 Total cubic yards needed

Note:
There are 27 cubic feet in a cubic yard.    Although this value was keyed in, it is simpler to 

let the Conversion Master remember your conversion constants for you.    Conversion 
constants can be retained through the use conversion tables and called up at any point in 
time by Selecting Options and then Perform Conversion from the menu.    Many commonly 
used conversions come with the Conversion Master, including this one.



CALCULATING CUBIC YARDS
EXAMPLE # 2

You have 175 linear feet of concrete footing to pour.
How may cubic yards of concrete are needed for this footing?
There are 27 cubic feet in a cubic yard.

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
2      0      0 2' - 0" # 2 Height
X 2' - 0" # 2
1      4      0 1' - 4" # 2 Width
X 2'- 8" # 2
1      7      5      0      

0
175' - 0" # 2 Linear feet

= 466.6666655 # 1 Cubic feet 
/ 466.6666655 # 1
DEC 466.6666655 # 1 change mode
2      7 27 # 1 *See Note Below
= 17.28395057 # 1 Total cubic yards needed

Note:
There are 27 cubic feet in a cubic yard.    Although this value was keyed in, it is simpler to 

let the Conversion Master remember your conversion constants for you.    Conversion 
constants can be retained through the use of conversion tables and called up at any point in 
time by Selecting Options and then Perform Conversion from the menu.    Many commonly 
used conversions come with the Conversion Master, including this one.



CALCULATING THE VOLUME
OF A CYLINDER

Formulas:
                                                                

How many gallons of water will this barrel hold?

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
2      7      0 2' - 7" # 2 Diameter
/ 2' - 7" # 2
DEC 2' - 7" # 1
2 2 # 1
= 1.29166666 # 1 Radius
X² 1.66840276 # 1 Radius 

squared
X 1.66840276 # 1

3.14159265 # 1

X 5.24144185 # 1 Area of 
bottom

FIS 5.24144185 # 1 Area of 
bottom

X 5.24144185 # 1 Area of 
bottom

4      6      14 4' - 6 14/16" # 2 Height of 
barrel

= 23.96867681 # 1 Total cubic 
feet

The Conversion Table category Volume and Capacity must be loaded before converting to gallons.    
From the calculator menu select Options > Perform Conversion.    From the Conversion dialog select
action to perform: Cubic feet to Gallons (U.S., liq.).    The result (179.29815427) will appear in the 
Conversion Resultant display.    The resultant can be transferred to the calculator by use of the 
Resultant To Display button if desired.

Answer:    The barrel will hold 179 gallons of water



USING VOLUMES TO CALCULATE
CYLINDER LENGTHS

Formulas:
                                                                

A fuel tank is needed that will hold 55 gallons of diesel fuel.    This fuel tank is to be
made out of a cylinder 1' - 8" in diameter.    What is the length in feet of fuel tank?

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
DEC
5      5 55 # 1 Gallons

Next, the Conversion Table category Volume and Capacity must be loaded before converting gallons to 
cubic feet.    From the calculator menu select Options > Perform Conversion.    From the Conversion 
dialog select action to perform: Gallons (U.S., liq.) to Cubic feet.    The result (7.35224052) will 
appear in the Conversion Resultant display.    Copy this result to the Clipboard by selecting Edit > 
Copy Conversion Resultant.

FIS
1      8      0 1' - 8" # 2 Diameter
/ 1' - 8" # 2
DEC 1.66666667 # 1
2 2 # 1
= .83333333 # 1 Radius
X² .69444444 # 1 Radius squared
X .69444444 # 1

3.14159265 # 1

= 2.18166155 # 1 Area of bottom
STO      1 2.18166155 # 1 Store Area
Menu Edit Paste 7.35243052 # 1 Paste volume in cu/ft
/ 7.35243052 # 1 Volume in cu/ft
RCL      1 2.18166155 # 1 Area of bottom
= 3.37010593 # 1
FIS 3' - 4 7/16" # 2 Length of cylinder

Answer:    The cylinder will need to be 3' - 4 7/16" in length



FINDING THE VOLUME OF A CONE

Formula:      

Given:            r = 2 7/8"                                                                
                              h = 8"                                                                        

Find the Volume V:
in Ounces of U.S. liquid
in Cubic inches
in Milliliters

Load Conversion Table category Volume and Capacity from the menu to solve this problem.    Next, 
select perform conversions button.    From the Conversion dialog select action to perform:  Cubic feet 
to Ounces (U.S., liq.).

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS

3.14159265 # 1

X 3.14159265 # 1
2      14 2 7/8" # 2 Radius of the cone
X² .05740017 # 1 Area of the top of the 

cone
X .05740017 # 1
8      0 8" # 2 Height of the cone
= .12021864 # 1
/ .12021864 # 1
DEC .12021864 # 1
3 3 # 1
= .04007288 # 1 Volume in cubic feet

The result (38.37004267) will appear in the Conversion Resultant Display of the Conversion dialog.  
Press Resultant to Display button to place this conversion in the calculator main display area.

38.37004267 # 1 Volume in Ounces of 
U.S.,liq.

Next, select action to perform:  Ounces (U.S., fluid) to Cubic inches.
The result (69.24593638) will appear in the Conversion Resultant Display of the Conversion dialog.  
Press Resultant to Display button to place this conversion in the calculator main display area.



69.24593638 # 1 Volume in cubic 
inches

Next, select action to perform:  Cubic inches to Milliliters.
The result (1134.7375912) will appear in the Conversion Resultant Display of the Conversion 
dialog.    Press Resultant to Display button to place this conversion in the calculator main display area.

1134.7375912 # 1 Volume in 
milliliters



SOLVING OBLIQUE TRIANGLES
EXAMPLE # 1

Given:        a = 9' - 4 7/8"                                                                Find angle A
                          b = 20' - 11 1/4"
                          c = 22" - 11 7/16"

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS 0 # 2
9      4      14 9' - 4 14/16" # 2 a
+ 9' - 4 14/16" # 2
2      0      11      4 20' - 11 4/16" # 2 b
+ 30' -4 2/16" # 2
2      2      11      7 22' - 11 7/16" # 2 c
= 53' - 3 9/16" # 2
/ 53' - 3 9/16" # 2
DEC 53.296875 # 1
2 2 # 1
= 26.648437 # 1 S (solution)
STO      1 26.648437 # 1
X² 710.13922 # 1 S²
- 710.13922 # 1
RCL          1 26.648437 # 1
X 26.648437 # 1
FIS 26' - 7 13/16" # 2 S
9        4        14 9' - 4 14/16" # 2 a
= 459' - 5 12/16" # 2
/ 459' - 5 12/16" # 2
2        0        11        4 20' - 11 4/16" # 2 b
/ 21' - 11 5/16" # 2
2      2      11      7 22' - 11 7/16" # 2 c
DEC 22.953124 # 1
= .9560871 # 1
SQR .9777970 # 1
INV          COS 12.09621 # 1
X            2            = 24.192432 # 1 Angle a in degrees
COS 24°·12'·33" # 2 Deg.·Min.·Sec.



SOLVING OBLIQUE TRIANGLES
EXAMPLE # 2

Formula:        

Given:        b = 20' - 11 1/4"
                          c = 22' - 11 7/16"
                          A = 30°

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS 0 # 2
2      0      11      4 20' - 11 4/16" # 2 b
X² 438.37890 # 1
+ 438.37890 # 1
2      2      11      7 22' - 11 7/16" # 2 c
X² 526.84594 # 1
- 965.22484 # 1
DEC 965.22484 # 1
2 2 # 1
X 2 # 1
FIS 2 # 1
2      0      11      4 20' - 11 4/16" # 2 b
X 41' - 10 8/16 # 2
2      2      11      7 22' - 11 7/16" # 2 c
X 961.1621 # 1
DEC 961.1621 # 1 A
3      0 30 # 1
COS .8660254 # 1
= 132.83402 # 1
SQR 11.525364 # 1
FIS 11' - 6 5/16" # 1 a



SOLVING OBLIQUE TRIANGLES
EXAMPLE # 3

Formula:        

Given:        a = 9' - 4 7/8"
                          A = 40°
                          B = 80°

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS 0 # 2
9      4      14 9' - 4 14/16" # 2 a
/ 9' - 4 14/16" # 2
DEC 9.4062499 # 1
4        0 40 # 1 Angle A
SIN .6427875 # 1
X 14.633527 # 1
8        0 80 # 1 Angle B
SIN .9848077 # 1
= 14.411211 # 1
FIS 14' - 4 15/16" # 2 b



SOLVING RIGHT TRIANGLES
EXAMPLE # 1

Given:        A = 4' - 8 7/16",            C = 11' - 5 3/16"
Find:            Bevel 'V' 
                          Run 'A' 
                          Convert Tangent to Degrees, Minutes & Seconds

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
4        8        7 4' - 8 7/16" # 2 Rise
RIS 4' - 8 7/16" # 2 Rise entered
1        1        5        3 11' - 5 3/16" # 2 Slope
SLP Slope = 11' - 5 3/16"

Slope = 11.43229167
Run = 10' - 5 1/16"
Bevel = 5 7/16"
Rise = 4' - 8 7/16"

# 2
# 1
# 1-1
# 1-2
# 2-1

Slope entered
Slope in Dec. of feet
Run result    'A'
Bevel result 'V'
Rise previous entry

INV        BEV Bevel = .45135243
Run = 10' - 5 1/16"
Rise = 4' - 8 7/16"
Slope = 11' - 5 3/16"
Angle          24°·17'·32"

# 1
# 1-1
# 1-2
# 2-1
# 2

Bevel result in dec. ft.
Run result
Rise previous entry
Slope previous entry
Angle result



SOLVING RIGHT TRIANGLES
EXAMPLE # 2

Given:        V = 6 15/16",            B = 21' - 11 15/16"
 Find:          Slope 'C'
                          Rise 'A'

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
6        15 6    15/16" # 2 Bevel
BEV 6    15/16" # 2 Bevel entered
2        1        11        15 21' - 11 15/16" # 2 Run
RUN Run = 21' - 11 15/16"

Run = 21.99479167
Rise = 12' - 8 9/16"
Bevel = 6 15/16"
Slope = 25' - 4 7/8"

# 2
# 1
# 1-1
# 1-2
# 2-1

Run entered
Run in Dec. of feet
Rise result 'A'
Bevel previous entry
Slope result 'C'



SOLVING RIGHT TRIANGLES
EXAMPLE # 3

Given:        A = 12' 11 3/4",             = 30°
 Find:          Bevel 'V',            Run 'B'      and      Slope 'C'
                          Change A = 10' - 6" Recalculate Run and Slope 

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
DEC
3          0 30 # 1

Angle 
TAN .57735027 # 1 Bevel 'V' Result

Bevel/Tangent of 30°

BEV .57735027
6.92820324"

# 1
# 2

Bevel entered
Bevel in dec. of inches

FIS .57735027
6 15/16"

# 2 Bevel previous entry
Bevel inches & 16ths

1      2      11      12 12' - 11 12/16"
12.97916667

# 2
# 1

Rise
Rise in dec. of feet

RIS Rise = 12.97916667
Run = 22' - 5 3/4"
Bevel = 6 15/16"
Rise = 12' - 8 9/16"
Slope = 25' - 11 1/2"

# 1
# 1-1
# 1-2
# 2
# 2-1

Rise in dec. of feet
Run result 'B'
Bevel previous entry
Rise entered
Slope result 'C'

1      0      6      0 10' - 6"
10.5

# 2
# 1

New Rise

RIS Rise = 10.5
Run = 18'- 2 1/4"
Bevel = 6 15/16"
Rise = 10' - 6"
Slope = 21'- 0"

# 1
# 1-1
# 1-2
# 2
# 2-1

Rise in dec. of feet
Run new result 'B'
Bevel previous entry
New Rise entered
Slope new result 'C'



SOLVING RIGHT TRIANGLES
EXAMPLE # 4

Given:        Run 'B' = 5.333 meters,            Rise = 'A' = 3.667 meters
 Find:          Bevel 'V',        and      Slope 'C'
 Find:          Rise 'A'    when Run 'B' = 1.750 meters 
                          Convert all values to FIS 

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
MET Change to Meter mode
5      .      3      3      3 5.333

5333
# 1
# 2

Run in Meters
Run in millimeters

RUN 5.333
5333

# 1
# 2

Run entered

3      .      6      6      7 3.667
3667

# 1
# 2

Rise in Meters
Rise in millimeters

RIS Rise = 3.667
Run = 5.333
Bevel = 6876
Rise = 3667
Slope = 6.4721

# 1
# 1-1
# 1-2
# 2
# 2-1

Rise entered
Run previous entry
Bevel result
Rise in millimeters
Slope result

RCL      BEV Bevel = .68760548
Run = 5.333
Rise = 3.667
Bevel = 687.60548
Slope = 6.4721

# 1
# 1-1
# 1-2
# 2
# 2-1

View bevel as last input
bevel to be retained
new run to be entered

1      .      7      5 1.75
17500

# 1
# 2

Run in Meters
Run in millimeters

RUN Run = 1.75
Rise = 1.2033
Bevel = 6876
Run = 1750
Slope =2.1238

# 1
# 1-1
# 1-2
# 2
# 2-1

New run entered
New rise result
Bevel previous entry
Run in millimeters
New slope result

FIS Run = 5.74146982
Rise = 3' - 11 3/8"
Bevel = 8 1/4"
Run = 5' - 8 14/16"
Slope = 6' - 11 5/8"

# 1
# 1-1
# 1-2
# 2
# 2-1

Values convert to FIS



SOLVING RIGHT TRIANGLES
EXAMPLE # 5

Given:        Half of overall span 15' - 3 1/4"
 Find:          Length of the ridge rafters (Slope) and total Rise and the angle of slope.

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS
5      0 5" # 2 Bevel\Pitch\

Tangent
BEV 5" # 2 Bevel entered
1        5        3        4 15' - 3 4/16" # 2 Run
RUN Run = 15' - 3 4/16" # 2 Run entered
INV        BEV Bevel = .41666667

Run = 15' - 3 1/4"
Rise = 6' - 4 3/8"
Slope = 16' - 6 1/2"
Angle          22°·37'·12"

# 1
# 1-1
# 1-2
# 2-1
# 2

Bevel result in 
dec. ft.

Run previous 
entry

Rise result
Slope result
Angle result



COMBINED TRIANGLES
EXAMPLE

Given:        Q = 10' - 5 5/8",                q = 4' - 8 7/16",                  L = 11' - 5 3/16"

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS 0 # 2
10      5      10 10' - 5 5/8" # 2 Q
STO      1 10' - 5 5/8" # 2
+ 10' - 5 5/8" # 2
4        8        7 4' - 8 7/16" # 2 q
= 15' - 2 1/16" # 2
STO      2 15' - 2 1/16" # 2
C 0 # 2
RCL      1 10' - 5 5/8" # 2
/ 10' - 5 5/8" # 2
RCL      2 15' - 2 1/16" # 2
X 8 4/16" # 2
1      1        5          3 11' - 5 3/16" # 2 L
= 7' - 10 11/16" # 2 S



 CALCULATING CIRCULAR SEGMENTS
EXAMPLE # 1

r = 11' - 11 15/16',              A = 30°

KEYS PRESSED DISPLAY RESULT DISPLAY AREA REMARKS
FIS 0 # 2
1      1      11      15 11' - 11 15/16" # 2 RADIUS    'r '
STO      1 11' - 11 15/16" # 2
X 11' - 11 15/16" # 2

3.14159265 # 1

X 37.68274935 # 1
DEC 37.68274935 # 1
3        0 30 # 1 ANGLE ' A '
/ 1130.48248046 # 1
1        8        0 180 # 1
= 6.28045822 # 1
FIS 6'    - 3 6/16" # 2 ARC ' a ' = 6' - 3 3/8"
C 0 # 2
DEC 0 # 2
3        0 30 # 1
/ 30 # 1
2 2 # 1
= 15 # 1 A ÷ 2
SIN .2588189 # 1
X .2588189 # 1
RCL          1 11.99479167 # 1 RADIUS    'r '
= 3.10448058 # 1
X 3.10448058 # 1
2 2 # 1
= 6.20896116 # 1
FIS 6' - 2 8/16" # 2 CHORD ' c ' = 6' - 2 

8/16"
C 0 # 2



DEC 0 # 2
1        5 15 # 1 A ÷ 2
COS .96592583 # 1
± -.96592583 # 1
+ -.96592583 # 1
1 1 # 1
= .03407417 # 1
X .03407417 # 1
RCL          1 11.99479167 # 1 RADIUS    'r '
= .40871257 # 1
FIS 4 14/16" # 2 M = 4 7/8"





Program Overview

THE CONVERSION MASTER ENGINEERING CALCULATOR
VERSION 2.01

Thank you for purchasing the Conversion Master Engineering Calculator, the most powerful 
dimensional and conversion calculator you will find for your computer.    By far it is the most useful and 
versatile calculator you can own and at a price that any household can afford.    The Conversion Master 
has a comprehensive help file system loaded with examples, how tos and explanations to get you up to 
speed quickly on its potential.

The Conversion Master has the ability to work with Meters, Decimals, Feet Inches Sixteenths, 
Degrees, Radians, Grads, Trig. functions, Bevels, Runs, Rises, Slopes and a multitude of user defined 
Conversions (self-constructed conversion tables).    The Conversion Master comes equipped with over 
3200 different conversions ready to access.    The Conversion Master can convert between Decimal, 
Feet-Inches-Sixteenths and Meters at the click of a button!

Dimensional calculations can be performed without the need of charts or tables, thereby 
increasing accuracy and production.    The Conversion Master also gives the user the ability to define his 
own conversion tables to accomplish almost every conversion imaginable.

The Conversion Master allows access to more information at one time than any other calculator 
through its use of Dual Displays which can utilize any of its six display blocks.    For example, when 
working with Degrees, the Conversion Master will display Degrees-Minutes-Seconds, Decimal of 
Degrees, Radians and Grads all concurrently.    In the Feet Inches Sixteenths input mode, the Conversion 
Master will continue giving the input value in Decimal of Feet, Decimal of Inches and Feet Inches 
Sixteenths in three of its display block areas.    When solving right triangles the Conversion Master will 
simultaneously display the Bevel, Run, Rise, Slope and the angle in Degrees, Minutes and Seconds when
any of two values are known.

Although the Conversion Master is designed as a dimensional calculator, it can also be used as a
standard calculator.    The second display can be hidden from view while working in the Meter and 
Decimal modes through the options menu.    The second display will automatically reactivate when in the 
Feet Inches Sixteenths mode or when a right triangle is solved.

The Conversion Master has three basic input modes 
      Feet-Inches-Sixteenths Mode (FIS key)
      Decimal Mode (DEC key)
      Metric Mode (MET key)
These modes can be switched at any time during or before entering
operators or operands.

The Conversion Master has a uniquely designed key pad layout that makes dimensional 
calculations easy.    Unlike a standard calculator the numeric keys are numbered from 0-15.    The 
extended numeric keys (10-15) allow Inches and Sixteenths input with a single keystroke.

The Conversion Master Calculator will be extremely useful to anyone working in the Construction 
Industry.
Contractors - Engineers - Architects - Draftsmen - Detailers - Carpenters - Fitters -

Fabricators - Surveyors and anyone linked to the Building and Construction
Trades Industry .

The Conversion Master will save you time and money and prevent costly mistakes.





Release History
      First Release    (Version 1.0 Beta/Evaluation Copy)

      Second Release    (Version 1.1 Beta/Evaluation Copy)
Improvements:

Help file enhanced
Conversions Categorized
Over 2000 conversions added
Feet, Inches and Sixteenths display added in MET mode

      Third Release    (Version 2.0 Beta/Evaluation Copy)
Fixes:

Fixed some minor problems with the help file:
*Help file was improperly called when the math category radio button
 was clicked and then the F1 key was pushed.
*Some of the help file popups were not displayed properly.

Fixed the problem of the Perform Conversions button on the Conversion
Categories dialog.    This button sometime would hide itself from view before the
Perform Conversions dialog was activated.

Improvements:
Several useful formulas were put on-line in the help file system

      Fourth Release    (Version 2.01 ShareWare Copy)
Fixes:

Fixed random problem with the reoccurring nag screen.
Improvements:

First Official release / Registration Made Available
More help file enchancements

Looking forward

      Ideas for future releases (Give me yours)
1000's more conversion
History tape
Parenthesis keys
Formula scripts



Known Bugs and Limitations
Version 2.01

      I need your feedback on this one.    If the program does not operate as described in the help file or if 
you think you have located a bug please contact me.    Before contacting, take time to reproduce the 
problem and then document it.

      Although care was taken in creating the conversion tables that come with Conversion Master there is 
always a possibility of human error.    In beta version 1.1 conversions were placed into categories to 
enable easier access.    Please report any inconsistencies with regard to category placement and 
conversion inaccuracies.

      The maximum number of conversion table entries per category is 650.

Contact me directly at: Roger L. Moseby
11802 E. 79th N.
Owasso Ok. 74055

        Other contact points: CompuServe: 73144,1744
                    InterNet: 73144.1744@Compuserve.com
                          Voice: (918)-2726684

Copyright Notice

Conversion Master Engineering Calculator
Version 2.01

Copyright © 1994 by Roger L. Moseby.
For more information call (918)-272-6684

You may use Conversion Master on any computer, as long as only one person uses it at a 
time.    If several people use the software at the same time, you must pay one license fee for 
each additional person.    If you use the software on a computer network, you must pay for as 
many licenses as the number of people who use the software.

Conversion Master is protected by international copyright laws.    You are granted a 60 day trial
license.    If you use the software longer than 60 days you MUST purchase a license agreement.
See Order form for resgistration.

You may distribute complete copies of Conversion Master (Shareware version) to others for 
evaluation purposes only, as long as no file has been modified, and all files are included.    
Anyone you distribute this program to is also bound by the 60 day trial agreement.    Roger L. 
Moseby is licensing the software to you; it is not sold.    You may not distribute your licensed 
copy of the program.

LIMITED WARRANTY
ANY IMPLIED WARRANTIES INCLUDING ANY WARRANTIES OF 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED TO THE 



TERMS OF THE EXPRESS WARRANTIES.    ROGER L. MOSEBY SHALL NOT IN ANY CASE 
BE LIABLE FOR SPECIAL, INCIDENTAL, CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR
DAMAGES ARISING FROM ANY BREACH OF THESE WARRANTIES EVEN IF ROGER L. 
MOSEBY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.    Some states 
do not allow the exclusion or limitation of incidental or consequential damages, so the above 
limitation or exclusion may not apply to you.    This Warranty gives you specific legal rights, and 
you may also have other rights which vary from state to state.    Roger L. Moseby maximum 
liability shall not exceed the price paid by the enduser/licensee.

This computer program as described in this documentation is copyrighted by Roger L. 
Moseby.    Each product is licensed by Roger L. Moseby to the original purchaser and 
subsequent owner of the product for use only on the terms set forth in the License Agreement.    
Copying, duplicating, selling, or using the product contrary to the terms stated herein is in no 
way permitted.

      You are hereby granted a period of 60 days to evaluate this Shareware copy of the software.
Use beyond this period of time requires purchasing a registered (licensed) copy of the software. 
See Order form for resgistration.

      The evaluation copy of Conversion Master may be freely distributed free of charge in the 
form and only in the form set forth in the Readme file that comes with the evaluation copy of the 
program.    Any other means of distribution will require written permission from the author.







File Menu

      Dialogs invoked by

      Load Conversion Table

      Modify Conversion Table

      Exiting Conversion Master



Conversion Table Category Dialogs
Both the Modify Conversion Table and the Load Conversion Table menu items will bring up a dialog box.   
The Load Conversion Table dialog is used to select a Conversion Table to load into memory from which 
conversions will be performed.    Conversion Tables can be accessed in one of two ways.    First, they can 
accessed by clicking the Perform Conversion button on the Load Conversion Table Dialog box.    
Secondly, they can be accessed through the Options Menu selection Perform Conversions.    The 
Modify Conversion Table dialog will allow you to select a Conversion Table category to edit.



Load Conversion Table 

Click the part of the Dialog Box you want to know more about.

Selecting one of the option buttons merely loads the described category into memory.
See Performing Conversions and Modify Conversion Table
See also Common Conversion Abbreviations 



Clicking this button dismisses this dialog box 



Clicking this button invokes the Perform Conversion Dialog with the selected category loaded in memory.  
This button will not appear if the Perform Conversion Dialog is active.



Modify Conversion Table 

Click the part of the Dialog Box you want to know more about.

See also Modifying Conversion Tables, Load Conversion Table

Common Conversion Abbreviations 



Clicking this button opens the selected category for editing.    If the Perform Conversion dialog is active 
you will be unable to edit any category other than the one loaded into memory.    If any other category is 
selected for editing while performing conversions you will be prompted to close the perform conversion 
dialog box first.



Clicking this button cancels the pending operation and dismisses this dialog box



Area
This category contains conversion factors related to an area of land or the surface of an object which is 
measured in square units.    These units result from multiplying the length of the area or object by its 
width.    The square units of both the customary and metric systems are based on units of length and 
distance.

Sample of customary and metric units for area.

Customary Metric Metric Customary
1 sq. mile 2.5899881 km² 1 sq. hectometer 2.4710538 acres
1 acre 0.40468564 ha 1 sq. dekameter 119.599001 sq. yd.
1 sq. rod 25.29285264 m² 1 sq. meter 1550.0031 sq. in.
1 sq. yard 0.83612736m² 1 sq. decimeter 15.500031 sq. in.

1 sq. kilometer 0.38610216 sq. mi.
1 sq. foot 0.09290304 m² 1 sq. centimeter 0.15500031 sq. in.
1 sq. inch 6.4516 cm² 1 sq. millimeter 0.0015500031 sq. in.



Electrical
This category contains conversion factors related to the science or application of electricity.



Energy
This category contains conversion factors related to the capacity for doing work and overcoming 
resistance.
Units common to this category

1 Btu = 1054.35 joule
1 Calorie = 1000 cal
1 cal = 4.1868 joule
1 erg = 2.3892e-7cal
1 joule = 1e7 erg

The joule (J) is the amount of energy needed to move a mass of one kilogram through one meter with an 
acceleration of one meter per second per second.    The erg is the amount of energy needed to move one
gram through one centimeter with an acceleration of one centimeter per second per second.    The calorie 
(cal) is the amount of energy needed to raise the temperature of one gram of water by one degree 
Celsius from 14.5° Celsius to 15.5° Celsius.    A Calorie is equal to 1000 cals.    The British thermal unit 
(Btu) is the energy needed to raise the temperature of one pound of water from 60° Fahrenheit to 61° 
Fahrenheit.



Flow
This category contains conversion factors that relate to the quantity of a substance that flows in a certain 
period time (i.e. Cubic feet a second, etc....).



Force
This category contains conversion factors related to the energy being brought to bear against a mass 
causing motion or change.



Length and Distance
This category contains conversion factors that relate to lengths and distances.    Lengths and distances 
are measured from one point to another, usually along a straight line.    Length usually refers to the 
measurement of an object.    Distance usually refers to the measurement of the space between two 
places.
Sample of customary and metric units for length and distance.

Customary Metric Metric Customary
1 inch 2.54 cm 1 nanometer 0.00000003937 in.
1 foot 30.48 cm 1 micron 0.00003937in.
1 yard 0.9144 m 1 millimeter 0.03937 in.
1 rod 5.0292 m 1 centimeter 0.3937 in.
1 furlong 201.168 m 1 decimeter 3.3937 in.
1 mile 1.609344 km 1 meter 39.37 in.

1 dekameter 393.7 in.
1 hectometer 328.0833 ft.
1 kilometer 0.62137 mi.

See category terms



Light
This category contains conversion factors related to the flow of light.



Math
This category contains conversion factors related to mathematics.



Power and Work
This category contains conversion factors related to work and power.    Power is a measure of the amount
of energy spent over a certain period of time.    Work is the transference of energy from one body to 
another resulting in the motion or displacement of the body acted upon.

1 horsepower = 745.7 watt
1 horsepower 
(metric)

= 735.499 watt

1 watt = 0.00134102 horsepower
1 kilowatt = 1000 watt



Pressure
This category contains conversion factors related to Pressure.    In physics, pressure is force measured in 
terms of its distribution over an area of opposing force.    This is expressed as force divided by unit area of
the surface area to which the force is applied.    Pressure usually refers to a force exerted uniformly in all 
directions.    Absolute pressure is pressure measured with respect to zero pressure. Gauge pressure is 
pressure measured with respect to air pressure (the weight of one atmosphere).

Some of the common units are inches of mercury,(in of Hg) centimeters of mercury (cm of Hg), pounds 
per square inch (psi), atmospheres (atm), pascals (Pa), kilopascals (kPa), bars, millibars (mbars), and 
microbars (dynes).

1 atm = 14.69595 psi
= 29.92126 in. of mercury.
= 76 cm of mercury.
= 101.325 kPa
= 1013.25 mbars

1 Pa = 1 Newton per sq. meter
1 mbar = 1000 dynes per sq. cm



Time
This category contains conversion factors related to the measurement of time.

1 second = 1000 milliseconds 1 solar year = 365d, 5hr, 48min, 
45.51sec

1 minute = 60 seconds 1 astronomical year = 365d, 5hr, 48min, 
45.51sec

1 hour = 60 minutes 1 sidereal year = 366d, 6hr, 9min, 9sec
1 day = 24 hours 1 lunar year = 360d
1 week = 7 days 1 leap year = 366d
1 year = 12 months
1 century = 100 years
1 
millennium

= 1000 years

See category terms



Velocity
This category contains conversion factors related to the rate of movement in relationship to time.



Volume and Capacity
This category contains conversion factors related to volume and capacity.    Volume refers to the amount 
of space occupied by an object.    Capacity is the amount of a substance that a container can hold.    
Volume and capacity are both measured in cubic units.    Cubic units combine length, width, and depth.    
The names of many common cubic units, such as liter and quart, do not include the word cubic.

Sample of customary and metric units for volume and capacity.

Customary Metric Metric Customary
1 pint 473.1632 ml 1 kiloliter 264.1794 gal.
1 cubic inch 16.387064 cm³ 1 milliliter 0.06102545 cu. in.
1 cubic foot 0.028316847 m³ 1 centiliter 0.6102545 cu. in.
1 cubic yard 0.7646 m³ 1 liter 61.02545 cu. in.



Weight and Mass
This category contains conversion factors related to weight and mass.    Weight is the heaviness or 
attraction of a material body by gravitational pull toward the center of the earth.    Mass is the quantity of 
matter in a body as measured in its relation to inertia.    The customary system measures the weight of 
various materials.    The metric system measures mass (amount of material something contains).    An 
object's mass does not change, but its weight decreases with altitude.    These two measurement units are
equal at sea level on the earth.

Sample of customary and metric units for weight and mass.

Customary Metric Metric Customary
1 grain 0.06479891 g 1 milligram 0.015432358 gr.
1 ounce 28.349523 g 1 centigram 0.15432358 gr.
1 pound 0.45359237 kg 1 gram 15.432358 gr.
1 ton 0.90718474 t 1 kilogram 2.2046226 lb.

1 metric ton 2,204.6226 lb.

See category terms



Modifying Conversion Tables

Click the part of the Dialog Box you want to know more about.

See also Performing Conversions.



Enter in this location a conversion description that is unique and self explanatory of the conversion to be 
performed.    This description is limited in size to the size of the text box entry area.



Select from this list box a Conversion Table Item to edit.



Click this button to update a previously selected Conversion Table Item.



Click this button to save a new a Conversion Table Item.    Note that a table size is limited to 650 items.



Click this button to delete items from the Conversion Table List box.



Select the operation to be performed.    This operator will be used to perform a conversion against the 
calculator main display and a constant value.



Enter the conversion constant here - it must be a valid numeric expression.    This is the number that will 
be used in conjunction with the operator and the calculator display to compute a resultant value.



Clicking the close button will dismiss this dialog box and update the Conversion Table.



This area displays the size of the Conversion Table and the number of the selected entry being edited.



The window caption bar displays the Conversion Table category name.



Exiting Conversion Master
Conversion Master will automatically detect changes in calculator settings.    Upon exiting the program, 
you will be prompted to update the Conversion Master initialization file.    Changes detected are: Memory 
and Constant changes; changes in the conversion category usage (loading a different Conversion 
Tables); changes in modes (FIS, DEC & MET); changes in display accuracies (decimal and fractional); 
and changes in display viewing (hiding/unhiding alternate display).



Edit Menu
Main Display #1, Main Display #2, Conversion Table Resultant or Conversion Table Constant can be 
copied to the clipboard from the Edit menu.    Also, any valid numeric expression can be pasted to the 
calculator.



Memory Menu
The Memory Menu is used to view and retrieve values that were previously stored in memory. This gives 
you the ability to view before retrieving.    Optionally, the RCL key can be used to retrieve memory values 
provided the memory location of the desired value is known.    These values are stored through the STO 
key or the use of Option menu item Change Memory.    The Memory Menu selections can be used in the 
same manner as the RCL key when performing math functions.    All values in memory are floating values 
i.e. they will be converted when the calculator mode is changed (See DEC, FIS, MET).    Use the 
Constants Menu to access constant values.    The last entered memory values will be retained when 
Conversion Master is exited.



Constants Menu
The Constants Menu item is used to view and retrieve values that were previously stored as constants.    
This gives the ability to view before retrieving.    These values are stored through the use of Option menu 
item Change Constants.    Math can be performed on the constant menu selections.    These values are 
labeled constants because, unlike memory values, constants will not change when the calculator 
undergoes a mode change.        Use the Memory Menu item to access floating values.    Constants will be 
retained when Conversion Master is exited.



Options Menu

Click on the menu item you want to know more about.



Change/Edit Constants Locations

Click the part of the Dialog Box you want to know more about.

Constant Locations (1-9) can be changed by selecting from a list box of constant values to edit.    The 
Change Value and Use Display buttons are disabled until a selection is made.



Click this text box when you want to change the value of a previously selected constant.



Select a constant location (from 1-9) to change from this list box.



Click this button to change a constant location to a new value.



Click this button to use the Calculator display as the new constant value.



Click this button to set all constant locations to zero.



Click here to dismiss this dialog.



Change/Edit Memory Locations

Click the part of the Dialog Box you want to know more about.

Memory Locations (1-9) can be changed by selecting from a list box of memory values to edit.    The 
Change Value and Use Display buttons are disabled until a selection is made.



Click this text box when you want to change the value of a previously selected memory location.



Select a memory location (from 1-9) to change from this list box.



Click this button to change a memory location to a new value.



Click this button to use the Calculator display as the new memory value.



Click this button to set all memory locations to zero.



Click here to dismiss this dialog.



Perform Conversion

Click the part of the Dialog Box you want to know more about.

Conversion Tables allow you to do many different types of conversions by simply choosing from a list 
box the type of conversion to invoke.    The resulting conversion can be placed in the calculator display if 
desired by clicking the Resultant to Display button.    This dialog box is modeless i.e. it does not require 
user action before switching to another window.    It can remain active in the background as new values 
are entered in the calculator.    These values will be converted and then displayed in this dialog's 
Conversion Resultant display area as they are entered.      See also Modifying Conversion Tables.



Click this list box to select a conversion to perform.



This area displays the value of the calculator main display.    The calculator main display is the value 
which will be acted upon. 



This is the operation and the constant value that will be performed against the calculator main display.



Clicking this button envokes a dialog box that enables the loading of another Conversion Table.        See 
Loading Conversion Tables



This area displays the result of the conversion operation.



Click this button to force the resultant value to calculator main display.



Click here to dismiss this dialog box.



The window caption bar displays the Conversion Table category name.



This area displays the table entry number of the selected conversion being performed.



Set Accuracies
These options set the display accuracy.    They allow for the setting of fractional accuracies from 16ths to 
128ths and decimal accuracies from 4 to 13 places.    Default    settings are considered to be 16ths In the 
FIS mode and 8 decimal places in DEC and MET modes.    When exiting Conversion Master, new settings
can be retained when initialization file is updated.



Toggle Alternate Display
This option allows the user to turn off the second display when its information is not relevant.    Note that 
there are two conditions that will automatically activate the second display:
      When the calculator has solved a right triangle using the BEV, RUN, RIS or SLP keys.
      When the calculator is In the FIS mode.



Help Menu
The Help menu invokes various aspects of this help system and the program's About Dialog box.







Formulas for solving Right Trianlges

Required angle or side
Known A B a b c Area
a,b ________ ________

a,c ________ ________

A,a ________ ________

A,b ________ ________

A,c ________ ________

Formulas for solving Oblique Trianlges

Required angle or side
Known A B C b
a,b,c _______ _______________

a,A,B _________________ ________________

a,b,A _________________ ________________ _______

a,b,C ________________ ________________ _______

Formulas for Plane figures



Plane Figures Area
Circle

Ellipse

Triangle

Square

Rectangle

area = lw

Formulas for Shaped figures

Shape (Surface) Area Volume
Rectangular Prism



2hw
+ 2hl + 2lw

Cube

Sphere

Cylinder

Cone



(
 if you add the base)




